Outpost
TNC Message Manager

Release Content Description
For Version 1.2

Version: 1.2
Date: May 2004



Outpost TNC Message Manager
Version 1.2 Release Content Description

Contents

1 INTRODUCTION . ittt e e s s s a e e e s e s sabbr s e e s e s s sabbabeeeeeessabbabeeesesssasbbaberesessan 1
1.1 PURPOSE OF THE DOCUMENT ......uvviiiiitiiieeeteeeeeeeeeeeeeeeeeeaeeeeeeaeeeeetaeeeseneeeesennaeesatresssnnnnessenneeeeas 1
1.2 ORGANIZATION ....coouitirrieeeeeeeeiitteeeeeeeeetiareeeeeeeeeeiaaeeeeeeeeestaaaereeeeeeesisrsseeeeeeeaitssseeeseeaanrasseeeeeenans 1

2 NEW FEATURES. ...ttt ettt ettt e et e e e et e s e bt e e s easae e e s eabaee s e saeeesassensssnseeessanreeesn 2
2.1 #235: ASSOCIATE A TNC WITH A COMM PORT ....ouvviiiiiiiiiiieiee e 2
2.2 #238, 253 ONLINE REPORTS....uvvviiiiiiiiieeeieee ettt e eeaaae et e e e e e eaaateeeeeeseesnnsaaeeeeesesnnnsssneeeesenns 2
2.3 #257: DIRECTORY MANAGEMENT ......oiiuttttiieeeiieeeeeeeeeeeeeeaaeeeeeesseesnsseeseeessssnssseseessssssnsssseeessennns 2
24 #258: SAVEALL MESSAGES IN ONE FILE ....ecoiiiiiiiiiiiieeeeeeeeeieeeeeeeeeeesnsreeeeeesessnsssseeessessnnssseeessennns 2
2.5 #259: MESSAGE NUMBERING TO SUBJECT LINE ....uuvviiiieiiiiiiireeeeeeeeeiiereeeeeeeeessnreeeeeessessnssseeessennns 3
2.6 #260: SET DEFAULT DESTINATION.......coiiuuuveiieeeiieiiteeeeeeeeeesaseeeeeeseeesiasreeseesssesssnsseseesssssssssseeessennns 3
2.7 #262: SELECTIVE RETRIEVAL OF BULLETIN MESSAGES ....cccittiiiiiiiiiiiiiiiiiieeeeeeeeeeeeeeeeeeeeeeeeeeeeenenens 3
2.8 #263: CANADIAN POSTAL CODE SUPPORT .......coovuuvveeieeeeeeeiireeeeeeeeesitreeeeeeeeesiarereseseeesesssreseseennns 3
2.9 #264: PRINT MESSAGES ON RECEIPT ......uuuvviiiieeiieiitreeeeeeeeesiareeeeeeeeesiasrereseeeeesssseeeseseeesnsssseseseesnns 4

3 MINOR AND INTERNAL CHANGES, BUG FIXES.......cooii e 5
3.1 #159: REMOVE PRINT PREVIEW .......ooitiiitiiiiiieeiieiiiieeee e e eeeeiteee e e eeeetveeeeeeeeeeeanaeeeeeeeeenrasseeeeeenns 5
32 #237: INI FILE STRUCTURE CHANGE ........uvviiiieiiieiiirieeeeeeeeeeiiureeeeeeeeesisreeeeeeeeesisssseseseeesesssseseseennns 5
33 #248: MESSAGE NOT SAVED (DEFECT) ..vviiuteeitteesiteesteeesteeesseeessseesseeessseessseessssessssessssssssssssssesseeanes 5
34 #251: CODE EFFICIENCY CHANGES ......uttetiiiieeiieiieeeeeeeeeeeeeteeeeeeseesnaseeseeesesssssseseessesssnnssseeessennns 5
35 #252: ADD "SENT: " LABEL TO MESSAGE DATE/TIME .......cccoouuttiiieieiieieeeeeeeeeiiieeeeeeeeeesnneeeeeeeseens 5
3.6 #256: SELECT MESSAGE WITH ENTER ......uuviiiiiiiiiiiiiiieee et eeeetee e e e e e et e e e s e eennaaaneeeeeeenns 5
3.7 #265: IPW PROPERTY CHANGES (DEFECT) ..veeiuteeitreestreetreenieeeseeesseesssseessseessseesssessssesssessssssssseennns 5
38 #266: ADD PRINTER SETUP MENU ......ciiiiuuuriieieeiieiiteeeeeeeeeeeiaeeeeeeeeeesasseeeeesseessssssesessssssssssesessennns 5
39 #268: PRINT HANDLING CHANGES .....ccooittvviiieeeiieiiteeeeeeeeeesiareeeeeeeeesisrereeeeeeesitssseseseeesisssseseseennns 6

4 CHANGES SINCE VERSION L.ttt sesiaabe e e e s s s e saabsae e s s s s e sabbaneeessessnnnes 7
4.1 RELEASE L1 1ottt e et e e e e et e e e e e eeeatbaeeeeeeeenataareeeeeeans 7
4.2 RELEASE L.1. 2. oottt et e e e e e et e e e e e eeesataaaeeeeeeenaraareeeeeenns 7

43 RELEASE L. 1.ttt et et e e e e e e et e e e e e e e e etbareeeeeeenaraareeeeeenes 7




Outpost TNC Message Manager
Version 1.2 Release Content Description

1 Introduction

11

1.2

Purpose of the Document

This Release Content Description document provides information about new or
changed functionality that will be found in Outpost TNC Message Manager

Release 1.2.

Existing functionality from the original release is not described here. For
current information on Outpost, refer to the following documents:

Name

Release Date

Outpost TNC Message Manager User Guide,
Version 1.1

March 2004

Organization

The information in this document is organized under the following headings:

=  New Features
=  Minor, Internal Changes, Bug Fixes
=  Changes since Version 1.1

5/9/2004 12:25 PM
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2 New Features

21

22

2.3

24

“New Features” are changes to Outpost that were identified as significant
functional changes needed to support the response mission. The following
changes were implemented in this area.

#235: Associatea TNC with a Comm Port

The TNC and Comm port are closely linked together, with one TNC connected
to one Comm Port. Currently, the Comm Port configuration is separated from
the TNC configuration. This means, if a user had multiple TNCs attached to
their computer, it is a 2-step process to (i) select the new TNC, and then (ii)
reconfigure the Comm Port for that TNC.

This enhancement now ties these to configurations together. The Comm Port
setting is no longer a stand-alone setting. Instead, when the user configures the
TNC, they now can select the Comm Port setting, with these settings now saved
with the TNC. Once configured, when the user changes to a different TNC, that
TNC’s previously defined Comm Port settings will be loaded with that TNC.

Configuring the Comm Port for the Interactive Packet Window can be still be
configured from that form from the File -> Comm Port Settings menu.

#238, 253: Online Reports

Several ARES/RACES organizations have developed standard report formats
for collecting and transmitting packet information. In some cases, automated
tools have been used to generate reports using pre-defined forms that could be
interpreted for efficient processing.

This enhancement implements Online Reports. An Online Report consists of a
form that is developed off line and saved as standard ASCII file. Once it is
loaded into an Outpost message form, the form first updates a series of <tags>,
then guides the user to the information on the form that needs to be filled in.

A tag is a form variable that is substituted at load time. To support Online
Reports, three categories of tags are defined. Automatic tags include date, time,
message no, BBS, and station call sign. Local tags can be defined for the local
environment (city, state, county, etc). Three custom tags provide customizable
string substitution (textl, text2, text3). In all cases, tags can be defined in a new
form under the “Tools->Report Settings” menu.

#257: Directory Management

There are several enhancements that now require directories for storing files,
such as the Export and Reports features. Changes have been made to the File
control forms so that the last used directory is used the next time it is selected.

Additionally, a new Tools form has been added so that these directories can be
viewed or changed.

#258: SaveAll messagesin onefile

Similar to #255 Export Outpost Messages, there may be a requirement to store
or print an entire folder or message database in a readable format.

5/9/2004 12:25 PM
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2.6

2.7

2.8

This enhancement allows you to save all the messages in a specific folder to a
text file that is printer or viewer ready. This file will be a lot easier to read than
the Export Message File.

#259: M essage numbering to subject line

Most ARES/RACES assign a message number to all traffic passed between
stations. By assigning a message number to a message, the originating and
receiving stations can accurately identify and track a message throughout its life.

This feature gives the user the option to automatically place a unique message
Identifier in the Subject String ahead of the subject. This is an optional feature.
The message number can be either a 3 digit number or, if the 3-character
Tactical ID is set, can be the combination of the Tactical ID and 3 digit number.
Setups for these parameters are made using Outpost’s “Tools->Report Settings”
menu.

#260: Set default destination

For field stations that primarily communicate with a single central station, the
same destination address is used from one message to the next.

This enhancement gives the user the option to define a Default Destination call
sign. Then, when a new message is started, the default destination call sign is
placed into the TO: Field on the message form. The user can change the TO
Field at message creation time.

#262: Selective Retrieval of Bulletin M essages

Currently, retrieving bulletins with Outpost is an all-or-nothing proposition.
That is, either all bulletins are retrieved or none are retrieved. This is fine when
the BBS is exclusively dedicated to a Response Organization’s mission, or when
Bulletins are periodically deleted, or when private messages are exclusively
used.

However, for the Response Organizations that rely on networked BBSs for their
message traffic where operational and non-operational traffic may be present, or
when a BBS is used to post a variety of bulletin data, retrieving ALL bulletins is
not an efficient use of the frequency.

Most BBSs offer one or more commands that allow the user to retrieve
messages based on the destination Call Sign or the message’s category

(category @ route). This enhancement adds the capability to selectively retrieve
messages during a TNC Session. The user will identify the “selective retrieve”
command (such as “L”, “L>", etc) as part of the Outpost BBS setup. Up to three
masks (to match a category or destination call sign) are entered on the Tools-
>Send/Receive Settings form. A 4™ retrieve cycle is also added to the TNC
Session Manager to retrieve the messages that match the filter.

#263. Canadian Postal Code Support

Outpost’s NTS message maker was implemented with support for the US 5-digit
Zip Code format. Unfortunately, this format is not consistent with the Postal
Codes used in Canada.

This change adds support for the Canadian Postal Codes. Canadian Postal
Codes are in the format L#L #L# where “L” is a character and “#” is a numeral.
Outpost now correctly interprets these codes (either 6 characters without the

5/9/2004 12:25 PM
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space or 7 characters with the space) and formats the NTS destination address
accordingly.

#264: Print messages on receipt

One of the original features of Outpost was its ability to retrieve messages
automatically from the BBS by configuring it to poll the BBS on a periodic
basis. When Outpost is physically located in the radio room and configured
with the call sign of a radio room operator, Outpost meets the requirement for
having a control operator present.

When a message is retrieved and stored on Outpost, there is a simple
annunciation to indicate a new arrival. However, it still requires an operator to
review new messages, print them, and route them to the appropriate staff
member in the EOC. This process may vary from one response organization to
another.

This enhancement allows the Emergency Responder organization to configure
Outpost to automatically print a message on receipt to a printer. This
enhancement assumes that all in-coming messages are of importance to the
EOC, and getting them to the EOC as quickly as possible is required.

5/9/2004 12:25 PM
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3 Minor and Internal Changes,
Bug Fixes

31

3.2

3.3

34

3.5

3.6

3.7

3.8

The following are a list of minor and internal changes that should improve
Outpost user experience. Additionally, changes that resolved application defects
are also listed.

#159: Remove Print Preview

This was an idea with the first release. Subsequently, I’ve determined there is
no valid requirement to preview a message prior to printing it (text is text).

#237: INI file structure change

Finally, this was bugging me since day one. This change implements an
interpreted INI file structure that no longer requires it to be deleted from one
version to another.

#248. M essage not saved (defect)

Any change to a message being created flags the application that a change is
made. This is used to determine if the Message not saved” prompt is issued if
the user tries to close the form without saving it. The correction fixes the case
when the change is made by pasting something in from the clipboard.

#251:. Code efficiency changes

This change replaced various string functions with more code-efficient
functions. This change is transparent to the user.

#252: Add " Sent: " label to message date/time

Very minor issue, but cleans up the message look and feel.

#256: Select message with Enter

While the up and down cursor keys could highlight a message, it still took a
mouse click to open it. This change allows you to remain “mouse-free” and
open a message by pressing the Enter key.

#265: | PW property changes (defect)

This was more of a nuisance than a defect. When accessing the TNC with the
Interactive Packet Window and you are connected, if you change the comm. port
settings (part of troubleshooting), these settings were not applied unless you did
a disconnect and reconnect. This change now forces a disconnect/connect to
apply the changes.

#266: Add printer setup menu

Adds a standard Printer Setup menu for setting the printer for all Outpost
printing. The menu is added to the Outpost main and Message forms.
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3.9 #268: Print handling changes

This is a variety of internal changes around print handling that should be
transparent to the user.
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4 ChangessinceVersion 1.1

4.1

4.2

4.3

The following is the list of changes that were released as part of the
Maintenance releases that followed the release of Outpost v1.1.

Release 1.1.1

#199: resolves Printer problem for non-HP printers. Page number and page
break were occurring on the top of the next page.

#202: added a user warning if a new message is closed without saving it. This
prevents a user from creating a message, then pressing Close or "X", and loosing
the message.

#229: resolves NTS message handling during retrieves from the BBS. This was
a problem since 1.0 with retrieving NTS messages you may have just uploaded
to the BBS.

Release 1.1.2

#196: Corrects problem with sorting date and size fields in the message list.

#233: Fixes problem where the Interactive Packet Window did not remember its
form settings.

#243: Corrects potential problem with the Interactive Packet Window where a
user may have pased a large message into the window that could have
overflowed the TNC buffer.

Release 1.1.4
#255: Export Outpost Messages

On completion of an operational deployment where Outpost was used, it may be
required to submit all necessary documentation and files that were generated
during the event to support the served agency’s or municipality’s request for re-
imbursement.

Additionally, during an upgrade from one release of Outpost to the next (such as
v1.1 to v1.2), the message database structure periodically changes causing any
previously saved messages to be lost.

This enhancement allows the user to export the entire message database to a
comma-delimited format, then imported into a future release. This feature was
back-ported into v1.0.6 and v1.1.4. See the user documentation for a description
of the fields.
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